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Introduction to Microsoft Word 2000 
 
 
The Word Screen 
 
When you start Word, an application window appears which displays a title bar, a menu bar, one 
or more toolbars, and the status bar.  When you open a new or existing document, a document 
window appears displaying a title bar, a ruler, and horizontal and vertical scroll bars. 
 
 
 
 

 
Figure 1 
 
 
 
Title Bar 
 
The title bar, located at the top of the window, displays the name of the application and the name 
of the document. Until you save a document and give it a name, the temporary name for the 
document is DOCUMENT1. 
 

Title Bar Menu Bar 

Toolbars 

Ruler 

Scroll Bars 
Status Bar 

Document 
Window 



 
 
Copyright  2001 by Computer Services Southeast Missouri State University 2 

Menu Bar 
 
The menu bar, located below the title bar, displays the pull-down menus for Word commands. 
 
 
Toolbars 
 
Toolbars, located below the menu bar, display the icons (buttons) for the most frequently used 
Word commands.  The two primary toolbars are the Standard Toolbar and the Formatting 
Toolbar.  The default is for them to be located side by side below the menu bar. 
 
 
Ruler 
 
The ruler, located below the title bar, contains the document’s tab and indent markers, margin 
markers, and boundaries for table columns. 
 
 
Scroll Bars 
 
The vertical scroll bar, located on the right side of the window, contains an up arrow, a down 
arrow, a scroll box, a Previous Page button, and a Next Page button.  The horizontal scroll bar, 
located at the bottom of the window, contains a left arrow, a right arrow, and a scroll box.  Each 
arrow, when clicked, lets you scroll in the corresponding direction.  Clicking and dragging a scroll 
box lets you move multiple windows at a time. 
 
 
Document Window 
 
The document window, located in the center of the screen, displays the work area for typing text 
and working with your document.  When the mouse pointer is in the document window, the 
pointer changes to an I-beam.  You can have as many document windows open as you need.  
Each window can be minimized, maximized, and sized. 
 
 
Status Bar 
 
The status bar, located at the bottom of the application window, contains information and 
messages, including:  the current page number, the section number, the total number of pages, the 
insertion point in the document, the view level, indicators, and context-sensitive messages. 
 
 
NOTE:  As you work with Word the menu commands and toolbar buttons that you use most 
often are stored as personalized settings and are displayed on the menus and toolbars.  In order to 
see toolbar buttons not displayed, click More Buttons. 
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Using the Mouse in Word  
 
• Point  Position the mouse pointer directly over the item you are selecting. 
• Click  Point to an item and then press and release the left mouse button one time. 
• Double-click  Point to an item and then press and release the left mouse button two times in 

rapid succession. 
• Drag  Point to an item and then hold down the left mouse button as you slide the mouse. 
• Drag and Drop  Select a block of text, click and hold down the left mouse button.  Move to 

the insertion (drop) point in the document. 
 
To Start Word 
 
1. Click the Start button and point to Programs. 
2. Click Microsoft Word. 
3. Word starts and displays a new, blank document window. 
 
To exit Word and return to Windows  
 
1. Choose the File Exit command or press Alt+F4 or click the Close button. 
2. If you did not save your document, Word asks whether you want to save/resave your 

document.  Choose one of the following: 
 
Option Effect 
Yes Saves the document and exits Word 
No Does not save the document and exits Word.  Any changes to the 

document since the last save will be lost. 
Cancel Cancels the command and remains in Word. 
 
 
Selecting Text With the Mouse  
 
To select Do This 
A word Double-click the word 
A sentence Press and hold CTRL and click in the sentence 
A paragraph Triple-click in the paragraph, or double-click in the 

selection bar next to the paragraph 
A line of text Click in the selection bar next to the line 
An entire document Press and hold CTRL and click anywhere in the selection 

bar, or triple-click in the selection bar 
A vertical block of text Press and hold ALT and drag through the text 
A large amount of text Place the insertion point at the beginning of the text, move 

to the end of the desired selection, then press and hold 
SHIFT and click 
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Inserting a Picture into a Document  
 
 
1. Place the insertion point in the document where you want to insert the picture. 
 
2. At the menu bar select Insert 
 
3. Select Picture 
 
4. Select Clip Art... 
 
5. Click one of the categories. 
 
6. Click one of the pictures. 
 
7. Click the Insert Clip button from the popup toolbar that appeared. 
 
8. Close the Insert Clipart window. 
 
9. Click the picture to select it.  The Picture toolbar should be displayed. 
 
10. Resize the picture by dragging the sizing handle. 
 
11. Click the Text Wrapping button on the Picture toolbar. 
 
12. Click either the Square or Tight button. 
 
13. To move the picture to a different location in the document, click the picture and drag it. 
 
14. To format the picture, click the picture with the right mouse button and select an option 

from the popup menu. 
 
 
 
 
NOTE: 
 
In order to move the picture to a different location in the document, the Text Wrapping feature 
has to be activated.  Otherwise, the picture cannot be moved; it can only be resized. 
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MICROSOFT OFFICE 2000 SUITE FEATURES  
 

 
(The following information was obtained from each application's on -line help.) 
 
Uninstalled Components 
 
Not all components were installed during the setup of Office 2000.  Office 2000 will give you the 
option to install them, as you need them. 
 
 
Detect and Repair 
 
This is a command on the Help menu.  Selecting this command will fix problems with noncritical 
files by reinstalling files that are missing or corrupt.  Problems with critical files are automatically 
detected and fixed when you open an Office program. 
 
 
The Office Assistant 
 
The Office Assistant appears whenever you access Help and is available to answer questions.  
Type a word or phrase in the text box and click Search.  Click one of the displayed topics.  It can 
also take you to the WEB for more information. 
 
When you start certain tasks, a light bulb will appear on the screen by the Office Assistant.  Click 
the light bulb to see the tip. 
 
To hide the Office Assistant, point to it and right click.  On the shortcut menu click Hide. 
 
To choose a different graphic as the Office Assistant, point to it and right click.  On the shortcut 
menu click Choose Assistant…  Follow the prompts. 
 
You can move the Office Assistant to another location on the screen by dragging it. 
 
 
Office Clipboard 
 
The Office Clipboard can now hold up to 12 objects.  The objects will remain on the Office 
Clipboard as long as one of the Office applications  remains opened. 
 
When more than one object is placed on the clipboard, the Clipboard toolbar appears containing 
a button for each copied/cut object.  If the toolbar does not automatically display, click View 
from the menu bar.  Click Toolbars.  Click Clipboard.  
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To remove the objects from the Office Clipboard click the Clear Clipboard button from the 
Clipboard toolbar OR close all the Office applications that are opened. 
 
The Office Clipboard is not the same as the Windows Clipboard.  The Windows Clipboard 
only holds one object at a time.  The item is removed from the Windows Clipboard when you 
shut down Windows. 
 
 
Dialog Box Options 
 
When a dialog box is opened, you can find out what each option does by clicking the question 
mark button located in the dialog box title bar, and then click the option.  A description of the 
option is displayed. 
 
Note:  To see a description of a toolbar button on menu command, click the What's This? 
option on the Help menu, and then click the command or item. 
 
 
Personalized Menus and Toolbars 
 
By default the Standard toolbar and Formatting toolbar share the same line.  This is to provide 
more screen space.  To change this default, click Tools   Customize…  Options tab.  Deselect 
the option Standard and Formatting toolbar share one row.  Click Close. 
 
Only the commands that you use most often are displayed on the menus and toolbars.  When you 
click a command, it is added to the menu.  Likewise, when you click a button, it is added to the 
toolbar. 
 
To see menu commands that are not displayed, click the double down arrow button at the 
bottom of the drop-down menu.  This will expand the submenu listing all the commands. 
 
To see toolbar buttons that are not displayed, click the More Buttons button located on the 
right of the toolbar. 
 
To always see all the menu options, click Tools   Customize…  Options tab.   
Deselect the option Menus show recently used commands first.  Click Close. 
 
 
Places Bar 
 
The Places Bar is located on the left side in the File Open and File Save As dialog boxes.  It 
provides access to folders and locations you use most.  Clicking the History button will display 
the last 20 to 50 documents and folders that you have worked with. 
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E-mailing a File 
 
A file created in the Office 2000 Suite can now be e-mailed directly using the application that 
created it.  You do not have to start your e-mail program in order to send a file to someone.  For 
example, in Word 2000 you can e-mail a document either by Sending a Copy of it or by sending 
it as an attachment.  If you choose the option to Send a Copy of it, the actual document becomes 
the e-mail message and is in HTML format.  If it is sent as an attachment, the document is sent in 
the regular Word format (.doc). 
 
Click the E-mail button on the Standard toolbar or click File    Send To  in order to access the 
e-mail option within the application. 
 
 
Office Binder 
 
You can use the Office Binder to keep related files, such as documents, spreadsheets, and 
presentations, created in different programs together in one file.  The binder becomes a single 
document, with one header and footer and continuous pagination. 
 
To start the Office Binder program , click the 
 Start button  Programs  Office Tools  Microsoft Binder 
 
Note:  If the Microsoft Binder command is not available, run the Microsoft Windows installer 
again to install the Office Binder. 
 
 
Clip Gallery 
 
There is a new Clip Gallery containing a wider selection of pictures available to insert into your 
document.  Clip Gallery can also store sounds and movies. 
 
To use the Clip Gallery, click  
 Insert  Picture Clip Art… 
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MICROSOFT WORD 2000 FEATURES 
 

 
Click and Type 
 
You can quickly insert text, graphics, and tables in a blank area of a document without having to 
press the ENTER key to add blank lines. 
 
By double-clicking in a blank area the insertion point is placed there and ready for you to begin 
typing.  Depending upon where you double-clicked, the text will automatically be centered, right-
aligned or left-aligned. 
 
To determine which formatting will be used, move the mouse pointer into different blank areas of 
the document called formatting "zones".  The mouse pointer will changes shapes according to the 
entered "zone".   
 
Click and Type  can not be used in the following areas:  multiple columns, bulleted and numbered 
lists, next to floating objects, to the left or right of indents, and to the left or right of pictures with 
top and bottom text wrapping. 
 
Click and Type  is not available in the following views:  Normal, Outline, and Print Preview. 
 
To turn on/off the Click and Type  feature, click 
    Tools  Options… Edit tab Enable click and type 
 
 
AutoFormat As You Type 
 
Word 2000 can format text automatically as you type, such as creating bulleted and numbered 
lists, defining styles, taking the formatting from the first item in a list and applying it to the next 
item in a list, etc. 
 
To turn on/off the AutoFormat As You Type  features, click 
    Tools  AutoCorrect… AutoFormat As You Type tab 
 
 
AutoText 
 
You can add or delete entries in the AutoText list.  This list is used when the AutoComplete 
feature is turned on.  If the AutoComplete feature is not activated, you can still insert entries from 
the list by clicking: 
    Insert  AutoText  AutoText… 
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AutoComplete 
 
Word can automatically offer suggestions for the rest of the word or phrase you are typing. 
 
To turn on/off the AutoComplete  feature, click 
    Tools  AutoCorrect… AutoText tab 

 Show AutoComplete tip for AutoText and dates 
 
 
AutoCorrect 
 
Use this feature to detect and correct typos, misspelled words, grammatical errors, and incorrect 
capitalization.  A red wavy line indicates a misspelling.  A green wavy line indicates a grammar 
error.  Point to the word and click with the right mouse button for a popup menu.  Click on the 
correct spelling for the word or click the grammar option. 
 
You can also use AutoCorrect to prevent unwanted spelling corrections by adding the words to 
the exceptions list. 
 
To turn on/off the AutoCorrect features, click 
    Tools  AutoCorrect… AutoCorrect tab 
 
Also, click 
    Tools  Options…  Spelling & Grammar tab 
 
 
Letter Wizard 
 
You can quickly and easily create a new letter or change an existing letter in Word by using the 
Letter Wizard.  Word remembers the persons you've sent letters to and stores that information in 
a list.  So, the next time you send a letter, you can select the person from the list and Word will 
automatically fill in the rest of the information for you. 
 
To access the Letter Wizard feature, click 
    Tools  Letter Wizard… 
 
 
Document Map 
 
This option can be activated from the View menu option or from the Document Map button  on 
the Standard toolbar.  It will take the headings from the opened document and display them in a 
separate window.  Click on any of the headings in order to quickly go to that location in the 
document. 
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Word 2000 Example 
 

Create a Document: 
 
(Figure 3 on page 13 will be created using the following instructions.) 
 
1. Change the document’s margins to 1 inch for all sides. 
 a. Select File from the Menu Bar. 
 b. Select Page Setup... 
 c. Change:  Top, Bottom, Inside, and Outside margins to 1 inch. 
 d. Click the OK button. 
 
2. Type the document shown in Figure 2 on page 11 using the Times New Roman font with a 

pitch of 12.  Only press <ENTER> at the end of a paragraph or a single line that does not 
extend to the right margin. 

 a. Select Times New Roman from the Font button on the Formatting Toolbar. 
 b. Select 12 from the Font Size button  on the Formatting Toolbar. 
 
3. After entering the text, save the document as WORDEX in the My Documents folder. 
 a. Select File from the Menu Bar. 
 b. Select Save As... 
 c. Type:  WORDEX (Note: Don’t add an extension. Let the extension default to DOC.) 
 d. Click the Save button. 
 
Format, Spell Check, and Print the Document: 
 
1. Change the document title, “Introduction to Suites ,” to 14 point, bold, and center. 
 a. Select the title by clicking and dragging the mouse across the title. 
 b. Change the point size to 14 using the Font Size button  on the Formatting Toolbar. 
 c. Bold the title by clicking the Bold button on the Formatting Toolbar. 
 d. Center the title by clicking the Center button  on the Formatting Toolbar. 
 
2. Bold and underline the paragraph headings:  Suite Evolution, What A Suite Is, and 
 Popular Suites. 
 a. Select the first subheading by clicking and dragging the mouse across. 
 b. Bold and underline the highlighted phrase by clicking the Bold button and the Underline  
  button on the Formatting Toolbar. 
 c. Repeat steps a and b for each subheading. 
 
3. Italicize the words:  word processing, spreadsheet, database, and presentation graphics 
 a. Select the words by clicking and dragging the mouse across all of the words. 
 b. Italicize the highlighted words by clicking the Italics button  on the Formatting Toolbar. 
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Figure 2 
 
 
4. Bullet point and indent:   

• ease of learning and use due to consistent interface 
• special features and functions 
• enhancement of training and support 

 
 a. Select the phrases by clicking and dragging the mouse across and down until all three  
  lines are selected. 
 b. Bullet point the list by clicking the Bullets button  on the Formatting Toolbar. 
 c. Indent the list by clicking once the Increase Indent button  on the Formatting Toolbar.

Introduction to Suites 
 
Suite Evolution 
Next, Microsoft did the same thing with PC-based Office applications.  Suites have evolved 
considerably since then into integrated applications with enhanced functionality. 
 
What A Suite Is 
A suite adds value of its own in terms of integration and interoperability.  Most suites contain a 
word processing, spreadsheet, database, and presentation graphics component.  Suites increase 
productivity through: 
 
ease of learning and use due to consistent interface 
special features and functions 
enhancement of training and support 
 
Popular Suites 
Three popular suite packages today are: 
 
Microsoft Office 
Novell Perfect Office 
Lotus SmartSuite 
 
In 1988, Microsoft marketers bundled MacIntosh Office applications as a marketing gimmick.  
They put all the applications in a single box and sold them at an aggressive price. 
 
Regardless of the suite used, since they run under a Windows environment, the basic skills should 
transfer.  All contain the same functionality with different bells and whistles. 
 
 
[Type Your Name Here]  
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5. Numerically list and indent:   
 1.  Microsoft Office 
 2.  Novell Perfect Office 
 3.  Lotus SmartSuite 
 
 a. Select the suites by clicking and dragging the mouse across and down until all three suites  
  are selected. 
 b. Numerically list the items by clicking the Numbering button  on the Formatting Toolbar. 
 c. Indent the list by clicking once the Increase Indent button  on the Formatting Toolbar. 
 
6. Select the paragraph that begins “In 1988, Microsoft marketers...” by clicking and dragging 
 the mouse across and down until both sentences are selected.  Move this paragraph directly 
 beneath the heading, Suite Evolution by: 
 a. Clicking the Cut button from the Standard Toolbar. 
 b. Click so the cursor is in front of the “N” of  “Next.” 
 c. Press the ENTER key to insert a blank line. 
 d. Use the up arrow key  and move the cursor up. 
 e. Click the Paste button  from the Standard Toolbar.  
 
7. Run the Spell Checker for the document by clicking the Spelling and Grammar button  on 
 the Standard Toolbar. 
 
8. Substitute your name in the area marked [Type Your Name Here]. 
 
9. Resave the document by clicking the Save button on the Standard Toolbar. 
 
10. Insert a Picture by following the instructions on Page 4. 
 
11. Resave the document by clicking the Save button on the Standard Toolbar. 
 
12. Print the document by clicking the Print button  on the Standard Toolbar.   
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Introduction to Suites 
 
Suite Evolution 
In 1988, Microsoft marketers bundled MacIntosh Office applications as a marketing gimmick.  
They put all the applications in a single box and sold them at an aggressive price. 
 
Next, Microsoft did the same thing with PC-based Office applications.  Suites have evolved 
considerably since then into integrated applications with enhanced functionality. 
 
What A Suite Is 
A suite adds value of its own in terms of integration and interoperability.  Most suites contain a 
word processing, spreadsheet, database, and presentation graphics component.  Suites increase 
productivity through: 
 

• ease of learning and use due to consistent interface 
• special features and functions 
• enhancement of training and support 

 
Popular Suites 
Three popular suite packages today are: 
 

1. Microsoft Office 
2. Novell Perfect Office 
3. Lotus SmartSuite 

 
Regardless of the suite used, since they run under a Windows environment, the basic skills should 
transfer.  All contain the same functionality with different bells and whistles. 
 
 
[Type Your Name Here] 
 
 
Figure 3 
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Word 2000 Exercise 1 
 
Create a Document: 
 
1. Change the document’s margins to 1 inch for all sides. 
 
2. Type the following document using the Times New Roman font with a pitch of 12.  Only 
 press <ENTER> at the end of a paragraph or a single line that does not extend to the right 
 margin. 
 
3. After entering the text, save the document as WORD1 in the My Documents folder. 
 
 
Microsoft Word Files 
 
Computer Files 
A computer file is a collection of information stored as a unit and given a name.  A document 
created using Microsoft Word is saved as a file.  A filename consists of two parts:   
 
Filename 
Extension 
 
Disks 
Files are saved on disks, either the hard disk or floppy disks.  For easier management, disks are 
divided into sections called folders.  You can compare a disk to a file cabinet and folders to the 
hanging folders which contain documents.  
 
Filenames 
Therefore, a complete filename consists of the following: 
 
Drive 
Folder 
Filename 
Three-letter extension 
 
When you issue the File Save As command and type a file name such as WORD1, Word will give 
it the three-letter extension .DOC and save it in the current folder and on the current drive.  So, 
its complete name might look something like this:  C:\My Documents\WORD1.DOC. 
 
The filename can have up to a maximum of 255 characters.  An extension can have a maximum of 
three characters.  Microsoft Word places the three-letter extension DOC on files.  The filename 
and the three-letter extensions are separated with a period. 
 
[Type Your Name Here] 
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Format, Spell Check, and Print the Document: 
 
(An example of the completed document is on page 16.) 
 
1. Change the document title, “Microsoft Word Files ,” to 14 point, bold, and center. 
 
2. Bold and underline the paragraph headings:  Computer Files, Disks, and Filenames. 
 
3. Italicize the two phrases: 
 
  A filename consists of two parts: 
  Therefore, a complete filename consists of the following: 
 
4. Numerically list and indent:   
 1.  Filename 
 2.  Extension 
 
5. Bullet point and indent:   
 

• Drive 
• Folder 
• Filename 
• Three-letter extension 

 
6. Move the paragraph that begins “The filename can have up to ...” beneath the numerical list. 
 
7. Bold the words in the last paragraph:  File Save As. 
 
8. Substitute your name in the area marked [Type Your Name Here]. 
 
9. Run the Spell Checker for the document. 
 
10. Save the document.  
 
11. Insert a Picture by following the instructions on Page 4. 
 
12. Save the document.  
 
13.Print the document. 
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Microsoft Word Files  
 
Computer Files 
A computer file is a collection of information stored as a unit and given a name.  A document 
created using Microsoft Word is saved as a file.  A filename consists of two parts:   
 

1. Filename 
2. Extension 
 

The filename can have up to a maximum of 255 characters.  An extension can have a maximum of 
three characters.  Microsoft Word places the three-letter extension DOC on files.  The filename 
and the three-letter extensions are separated with a period. 
 
Disks 
Files are saved on disks, either the hard disk or floppy disks.  For easier management, disks are 
divided in sections called folders.  You can compare a disk to a file cabinet and folders to the 
hanging folders which contain documents.  
 
Filenames 
Therefore, a complete filename consists of the following: 
 

• Drive 
• Folder 
• Filename 
• Three-letter extension 

 
When you issue the File Save As command and type a file name such as WORD1, Word will give 
it the three-letter extension .DOC and save it in the current folder and on the current drive.  So, 
its complete name might look something like this:  C:\My Documents\WORD1.DOC. 
 
[Type Your Name Here] 
 
Figure 5 
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Word 2000 Exercise 2 
 
Create a Document: 
 
1. Change the document’s margins to 1 inch for all sides. 
 
2. Type the following document using the Times New Roman font with a pitch of 12.  Only 
 press <ENTER> at the end of a paragraph or a single line that does not extend to the right 
 margin. 
 
3. After entering the text, save the document as WORD2 in the My Documents folder. 
 
 
Working with Microsoft Word 
 
Overview 
The following topics will be briefly discussed in this document: 
 
Typing Text 
Switching Between Windows 
Closing a Document Window 
Disks 
 
Typing Text 
When you type a character into a document window, the character appears at the insertion point 
location.  The insertion point then moves one space to the right.  Microsoft Word has a word-
wrap feature that ends lines at the right margin.  You do not press Enter except at the end of short 
lines or at the end of a paragraph.  If you were to press Enter at the end of each line, Word would 
not be able to reformat the screen when you make changes. 
 
Closing a Document Window 
When you finish your work on a document, you should close its window to make memory space 
available for other uses.  This will help to speed up the overall performance of Microsoft Word 
and the Windows environment in general. 
 
Switching Between Windows 
Microsoft Word enables you to have several documents open at once and quickly switch between 
them.  To work in a particular document, click anywhere in its window, click the Window menu 
and select the file from the menu list, or press Alt+F6 to cycle between open windows. 
 
 
[Type Your Name Here] 
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Format, Spell Check, and Print the Document: 
 
(An example of the completed document is on page 19.) 
 
1. Change the document title, “Working with Microsoft Word,” to 14 point, bold, italicize, 
 and center. 
 
2. Bold and underline the paragraph headings:  Overview, Typing Text, Closing a 
 Document Window, and Switching Between Windows. 
 
3. Bullet point and indent: 
 

• Typing Text 
• Switching Between Windows 
• Closing a Document Window 
• Disks 

 
4. Italicize the phrase:  word-wrap feature. 
 
5. Bold the two “Enter” commands in the paragraph entitled Typing Text and the “Alt+F6” 
 command in the Switching Between Windows paragraph. 
 
6. Move the paragraph about Switching Between Windows beneath the Typing Text 
 paragraph. 
 
7. Copy the paragraph about Disks after the paragraph entitled Closing a Document Window.  
 The Disks paragraph can be obtained from the WORD1 document created in Exercise 1. 
 
8. Insert your name in the area marked [Type Your Name Here]. 
 
9. Run the Spell Checker for the document. 
 
10. Save the document.  
 
11. Print the document. 
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Working with Microsoft Word 
 
Overview 
The following topics will be briefly discussed in this document: 
 

• Typing Text 
• Switching Between Windows 
• Closing a Document Window 
• Disks 

 
Typing Text 
When you type a character into a document window, the character appears at the insertion point 
location.  The insertion point then moves one space to the right.  Microsoft Word has a word-
wrap feature that ends lines at the right margin.  You do not press Enter except at the end of 
short lines or at the end of a paragraph.  If you were to press Enter at the end of each line, Word 
would not be able to reformat the screen when you make changes. 
 
Switching Between Windows 
Microsoft Word enables you to have several documents open at once and quickly switch between 
them.  To work in a particular document, click anywhere in its window, click the Window menu 
and select the file from the menu list, or press Alt+F6 to cycle between open windows. 
 
Closing a Document Window 
When you finish your work on a document, you should close its window to make memory space 
available for other uses.  This will help to speed up the overall performance of Microsoft Word 
and the Windows environment in general. 
 
Disks 
Files are saved on disks, either the hard disk or floppy disks.  For easier management, disks are 
divided in sections called folders.  You can compare a disk to a file cabinet and folders to the 
hanging folders which contain documents.  
 
 
 
[Type Your Name Here] 
 


